Investigation

Tracking Jupiter’s Moons

Galileo discovered the four largest moons of Jupiter in 1610, and they are often referred to as the Galilean Moons. He was using a simple telescope and a keen mind. It is a testimony to his observational prowess that out of all the stars and bright objects he could see in the sky, he noticed that Jupiter and these four dimmer lights, which he assumed were stars, were stretched out along a straight line. When he looked again he saw that the positions had changed from one night to the next, which is not what stars do. After repeated observations he determined that they were moons orbiting around Jupiter.

Materials:
- HOU IP
- Images: jup5 to jup10

These images of Jupiter and its Galilean moons were taken at one-hour intervals on April, 1992.

I. Find the Moons
- Open: jup5 and jup6 with the contrast adjusted using Min/Max so the moons are visible. To help keep track of the moons, refer to them as # 1, 2, 3, & 4, starting from the bottom of the window. To see all four of Jupiter’s moons you may need to scroll the image within the window by clicking inside the scroll bar, or pressing on an arrow button to scroll by smaller steps, or dragging the scroll bar to make larger scrolls. (Click, Press, or Drag)

7.3. Record your image settings.

7.4. Which Direction is Each Moon Moving?
- Make a sketch of the jup5 image, or use the Print option in the File menu, then draw an arrow at each moon showing whether it appears to be moving closer to or further away from Jupiter. You can tell by eye which direction the two moons shown closest to Jupiter are moving. A way to answer this question for the other two moons is to compare position coordinates. Use Find in the Data Tools menu with the default setting. Do this for both images.

II. Making a Double Exposure
- Adding two images together to make a double exposure is another way to compare the positions of the moons in two images taken an hour apart.

- Starting with jup5 as the active window, use Add in the Manipulation menu. Click on Displayed image and scroll down to select jup6 for what to add. Click on Display result in new window.

- If you want to save this double image, select Save As from the File menu and enter a new file name including your initials, such as “jup56jd”.

- Use Find to get the brightness Counts for the Sky and the moons in all three images.

7.5. Adding the two images made the Sky about twice the value in either image. The moons, however, are not twice as bright. Why?

7.6. Which image did each moon come from? Compare moon coordinates in the double image with moon coordinates in one of the single images. Make a sketch, or Print out a copy, of the double image and draw in arrows from the jup5 position to the jup6 position of each moon.
You need to collect data on the positions of each of the moons in each of the 6 Jupiter images, jup5, jup6, jup7, jup8, jup9 and jup10, taken at 1 hour intervals.

7.7. For each image check the Image Info (under Data Tools) and record the date and time that the image was taken. Date is day/month/year and time is Universal Time, UT. Make a quick sketch of the image. Universal Time is the time in Greenwich England.

- In order to see how each moon moves during the time sequence represented by the six images, combine all six images into one composite image. This may be done in several ways: by adding all of them together at one time; by adding them together one at a time and checking after each addition; by subtracting some and adding some. You may think of some other ways. Try whatever you like. Once again keep a careful record of all that you do, including the names of the files you create and how you create them. Remember, your goal here is to create an image or images that will allow you to see as clearly as possible how these Moons are moving.

- Select Cascade or Tile in the Window menu to help manage multiple windows. Select the window you want to work with from the Window menu to bring it to the front as the active window. If the window has been reduced, maximize by clicking in the top right box of the screen. In order to maximize the window needs to be away from the bottom and right edges of the screen.

Here are ways to collect moon position data; you may think of more.

- Use the cursor to get the coordinates for the positions of each moon.
- Use Slice in the Data Tools menu to get the number of pixels between each moon and the center of Jupiter or between moon positions. (It helps to make the Slice window larger - on a PC by dragging the borders, on a Mac by dragging the bottom right corner.) Drag the cursor on the Slice graph to display values for distance along the Slice in pixels and brightness in Counts. Corresponding pixel \( (x, y) \) coordinates and Counts are shown in the Status Bar - be sure you understand the differences between the \( (x, y) \) values for the Image window and the values shown on the Slice graph.
- Use Find to get cursor coordinates for all six positions of each moon and use the Pythagorean Theorem to compute distances and speed. A hand calculator helps here.
- Make a sketch (or printout, if possible) of your composite image. If you sketch it, please take enough time so that it’s clear to someone else who looks at it. Share your results with other groups around you and see what approach they used that might be different from yours. This is particularly valuable as you begin to answer the questions below.

7.9. Identify on your sketch the orbits each moon is traveling in by putting the number of the moon at its initial position in jup5 and in its last position in jup10.

7.10. Which moon(s) appear to be traveling the fastest? slowest? Does this depend on the portion of the orbit you are examining? Explain your reasoning.

7.11. Record the direction and speed of each moon. Your units of speed will be either pixels/hr or mm/hr, depending on your method of collecting the data.

7.12. How do you explain the apparent paradox that, despite this fact that the moons all move at roughly constant speeds around Jupiter in almost circular orbits, your data shows that the speed seemed to change?

7.13. Draw a top view of Jupiter and each moon in its six successive positions.
IV: Interpreting Your Data

The four moons Galileo discovered in 1610 are named Io, Europa, Ganymede, and Callisto. This table shows the period and orbit radius for each moon. The period is the time for one complete revolution.

One more piece of information: the further the orbit from Jupiter, the slower the speed of the moon. This is because Jupiter’s gravity weakens with distance.

7.14. Who Is Io? For each moon, see if you can match the name with its number. Use a process of elimination, crossing out numbers that are not candidates.

7.15. Explain how you decided on the name for each moon.

<table>
<thead>
<tr>
<th>Moon</th>
<th>Period (days)</th>
<th>Orbit Radius (km)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Io</td>
<td>1.8</td>
<td>421,600</td>
</tr>
<tr>
<td>Europa</td>
<td>3.5</td>
<td>670,900</td>
</tr>
<tr>
<td>Ganymede</td>
<td>7.2</td>
<td>1,070,000</td>
</tr>
<tr>
<td>Callisto</td>
<td>16.7</td>
<td>1,883,000</td>
</tr>
</tbody>
</table>

The moon, Io.
The moon, Europa.
The moon, Ganymede.
The moon, Callisto.
V. The Mass of Jupiter

By analyzing images of Jupiter and its moons, you can determine values for the variables \( D \) and \( T \) in the equation below and solve for the mass of Jupiter, \( M_J \).

\[
M_J = \frac{4 \pi^2 D^3}{G T^2}
\]

In this equation, \( D \) is the radius of orbit of one of Jupiter’s moons and \( T \) is the time it takes the moon to complete one orbit (the orbital period). \( G \), the constant of universal gravitation, has a currently accepted value of: \( G = 6.67 \times 10^{-11} \text{ m}^3/\text{kg} \cdot \text{sec}^2 \). Note that this equation looks exactly like Kepler’s Third Law, as modified to incorporate Newton’s universal gravitation constant—it applies to any central body that is being orbited by a much less massive object; e.g., The Hubble Space Telescope orbiting the Earth, a moon around a planet, one of the planets around the sun, or the sun around the center of our Milky Way galaxy. In all these cases the mass of the orbiting body is insignificant compared to the mass of the central body, and as you can see, its mass is not even included in the equation. If the mass of the orbiting body were significant, they would be orbiting around a common center, and a different equation would be needed.

7.16. As a practice problem, use the equation above to find the mass of the Earth in kilograms given the following observational data. The period of the Moon around the Earth is 27.3 days and the mean radius of its orbit is 384,000 km. Use meters for the units of \( D \) and seconds for \( T \).

Determining the mass of Jupiter

a) You need the distance data you determined in the Tracking Jupiter’s Moons Unit for the images jup5 through jup10. Distances need to be in pixels; go back to the Tracking Jupiter’s Moons Unit and redo this if your original measurements were in millimeters.

b) For each image you also need to know the time of day of the exposure. Use Image Info in the Data Tools menu. Time is given as Universal Time, UT, which is the time at Greenwich, England. Universal Time is based on a 24-hour clock rather than our familiar 12 hour ones.

7.17. Organize your distance and time data in a neat table before you proceed. Call the distances for the moons to the left and below Jupiter in the image negative (-) and the distances to the right and above Jupiter positive (+).

7.18. For all four moons in all the images, plot the pixel distance from the center of Jupiter versus the time the image was taken.

7.19. What does the plot you made above represent?

7.20. Use your plot to estimate the maximum distance for the moon that reaches its turn-around point; i.e., the moon that seems to stop getting further away from Jupiter. Your pixel distance from question 7.7 can actually be thought of as the angle subtended by imaginary lines connecting Jupiter and its moon. Line \( D \) is the radius of the moon’s orbit.

We can use this “pixel angle” to find the radius, \( D \), in km once we convert the pixel value of Angle A to units of radians.
7.21. Convert the pixel value you found above to radians using the Information Box at the start of this option.

7.22. Use the Small Angle Approximation (pp. 26–29) to determine the radius of the moon’s orbit in kilometers.

\[ D = d \times A \]

where \( D \) is the radius of the moon’s orbit, \( d \) is the distance from Earth to Jupiter at the time the images were taken, and \( A \) is the angular distance of the moon from Jupiter in radians.

This is the value for one of the two variables you need in order to solve for the mass of Jupiter. To determine the period of the moon, which is the other variable, \( T \), you need to extrapolate from your data by sketching what you think the graph would look like with data for more hours. Use your extrapolation to estimate the time for one quarter of an orbit and for one half an orbit.

7.23. Use your estimates of time for 1/4 and 1/2 an orbit to determine the period of the moon.

7.24. Estimate how much possible error there is in your value for the period and explain how you made your error estimate.

7.25. You now have the period and radius for one of the moons. Use this information to determine the mass of Jupiter from the equation for \( M_J \). Use meters for the units of \( D \) and seconds for \( T \).

7.26. Find a data table and look up the currently accepted value for the mass of Jupiter. Determine the percent difference between the accepted value and your calculated (experimental) value using the following equation:

\[
\%\,\text{Difference} = \left( \frac{\text{accepted value} - \text{experimental value}}{\text{accepted value}} \right) \times 100\%
\]

Wrap Up:

7.27. Design an experiment that would allow you to obtain a more accurate value for the mass of Jupiter. Be specific.